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Chapter 1

Vivado Implementation Process

About the Vivado Implementation Process
The Xilinx® Vivado™ Design Suite enables implementation of Xilinx 7 series FPGA designs 
from a variety of design sources, including:

• RTL designs

• Netlist designs

• IP centric design flows

See Figure 1-1, Vivado Design Suite High-Level Design Flow, page 6.

Vivado implementation includes all steps necessary to place and route the netlist onto the 
FPGA device resources, while meeting the design’s logical, physical, and timing constraints. 

For more information about the design flows supported by the Vivado tools, see the Vivado 
Design Suite User Guide: Design Flows Overview (UG892) [Ref 1].

Vivado Implementation Supports SDC and XDC Constraints
The Vivado Design Suite implementation is a timing-driven flow. It supports industry 
standard Synopsys Design Constraints (SDC) commands to specify design requirements and 
restrictions, as well as additional commands in the Xilinx Design Constraints format (XDC).
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About the Vivado Implementation Process
Vivado Implementation Sub-Processes
The Vivado Design Suite implementation process includes logical and physical 
transformations of the design. The implementation process consists of the following 
sub-processes:

• Opt Design

Optimizes the logical design to make it easier to fit onto the target Xilinx device.

• Power Opt Design

Optimizes design elements to reduce the power demands of the target Xilinx device.

Note: This step is optional.

• Place Design

Places the design onto the target Xilinx device. 

• Phys Opt Design

Optimizes design timing by replicating drivers of high-fanout nets to distribute the 
loads.

Note: This step is optional.

• Route Design

Routes the design onto the target Xilinx device. 

X-Ref Target - Figure 1-1

Figure 1-1: Vivado Design Suite High-Level Design Flow
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About the Vivado Implementation Process
• Write Bitstream

Generates a bitstream for Xilinx device configuration. 

Flow Navigator Assembles, Implements, and Validates Your 
Design
The complete design flow is integrated in the Vivado Integrated Design Environment (IDE). 
The Vivado IDE includes a standardized interface called the Flow Navigator. 

The Flow Navigator assembles, implements, and validates the design and IP of the FPGA 
design. It features a push-button interface to the entire implementation process to simplify 
the design flow.

See Figure 1-2, Flow Navigator - Implementation Section. 

 

IMPORTANT: This guide does not give a detailed explanation of the Vivado IDE, except as it applies to 
implementation. For more information about the Vivado IDE as it relates to the entire FPGA design 
flow, see the Vivado Design Suite User Guide: Using the Vivado IDE (UG893) [Ref 2].

Tcl API Supports Scripting
The Vivado Design Suite includes a Tool Command Language (Tcl) Application 
Programming Interface (API). The Tcl API supports scripting for all design flows, allowing 
you to customize the design flow to meet your specif ic requirements.

Note: For more information about Tcl commands, see the Vivado Design Suite Tcl Command 
Reference Guide (UG835) [Ref 12], or type <command> -help.

X-Ref Target - Figure 1-2

Figure 1-2: Flow Navigator - Implementation Section
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Getting to Implementation
Getting to Implementation
The Vivado Design Suite includes a variety of design flows, and supports an array of design 
sources. In order to generate a bitstream that can be downloaded onto an FPGA device, the 
design must pass through implementation.

Implementation is a series of steps that takes the logical netlist and maps it into the 
physical array of the target Xilinx device. These steps include:

• Logic optimization

• Placement of logic cells

• Routing of connections between cells

Working in Project Mode and Non-Project Mode
The Vivado Design Suite lets you create a project f ile (.xpr) and directory structure that 
allows you to:

• Manage the design source f iles.

• Store the results of the synthesis and implementation runs.

• Track the project status through the design flow. 

TIP: The Vivado tools also let you work strictly in memory, without the need for a project file and local 
directory. 

Working in Project Mode

In Project Mode, a directory structure is created on disk to help you manage:

• Design sources

• Run results

• Project status

The automated management of the design data, process, and status requires a project 
infrastructure that is stored in the Vivado project f ile (.xpr). 

In Project Mode, the Vivado tool automatically writes checkpoint f iles into the local project 
directory at key points in the design flow.
Implementation www.xilinx.com 8
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Getting to Implementation
Working in Non-Project Mode

Working without a project f ile in the compilation style flow is called Non-Project Mode. 
Non-Project Mode allows you to work with the design in memory. Source files and design 
constraints are read into memory from their current locations. The in-memory design is 
stepped through the design flow without being written to intermediate files. 

In Non-Project Mode, you must run each design step individually, and set design 
parameters and implementation options using Tcl commands. 

Non-Project Mode allows you to apply design changes and proceed through the design 
flow without needing to save changes and rerun steps. You can run reports and save design 
checkpoints (.dcp) at any stage of the design flow. 

IMPORTANT: In Non-Project Mode, when you exit the Vivado design tools, the in-memory design is 
lost. For this reason, Xilinx recommends that you write design checkpoints after major steps such as 
synthesis, placement, and routing. 

You can save design checkpoints in both Project Mode and Non-Project Mode. You can only 
read design checkpoints in Non-Project Mode. 

Similarities and Differences Between Project Mode and Non-Project Mode

Vivado implementation can be run in either Project Mode or Non-Project Mode. The Vivado 
IDE and Tcl API can be used in both Project Mode and Non-Project Mode.

There are also many differences between Project Mode and Non-Project Mode. Features 
not available in Non-Project Mode include:

• Flow Navigator

• Design status indicators

• IP catalog

• Implementation runs and run strategies

• Design Runs window

• Messages window

• Reports window

Note: This list illustrates features that are not supported in Non-Project Mode. It is not exhaustive.

You must implement the non-project based design by running the individual Tcl commands:

• opt_design

• place_design

• route_design
Implementation www.xilinx.com 9
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Getting to Implementation
You can run implementation steps interactively in the Tcl Console or the Vivado IDE, or by 
using a custom Tcl script. You can customize the design flow as needed to include reporting 
commands and additional optimizations. For more information, see Running 
Implementation in Non-Project Mode. 

The details of running implementation in Project Mode and Non-Project Mode are 
described in this guide. 

For more information on running the Vivado Design Suite using either Project Mode or 
Non-Project Mode, see:

• Vivado Design Suite User Guide: Design Flows Overview (UG892) [Ref 1]

• Vivado Design Suite User Guide: Using the Vivado IDE (UG893) [Ref 2]

RTL and Synthesized Design
The Vivado Design Suite allows you to manage the entire FPGA design process, including 
RTL development, IP customization, synthesis, and implementation through to 
programming and validating the device. 

Adding Objects to Your Project

You can add the following objects to your project:

• HDL source f iles from Verilog, SystemVerilog, and VHDL

• Previously defined and configured Xilinx IP cores

• Digital signal processing (DSP) modules from System Generator.

• C-based DSP modules from Vivado High-level Synthesis (HLS)

• Embedded processor modules from Xilinx Platform Studio (XPS)

Importing Previously Synthesized Netlists

Vivado Design Suite supports netlist-driven design by importing previously synthesized 
netlists from Xilinx or third-party tools. The netlist input formats include:

• Structural Verilog

• SystemVerilog

• EDIF

• Xilinx NGC

For more information on the source f iles and project types supported by the Vivado Design 
Suite, see the Vivado Design Suite User Guide: System-Level Design Entry (UG895) [Ref 4]. 
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Getting to Implementation
Starting From RTL Sources

At a minimum, Vivado implementation requires a synthesized netlist. A design can start 
from a synthesized netlist, or from RTL source f iles.

IMPORTANT: If you start from RTL sources, you must first run either Vivado synthesis or XST before 
implementation can begin. The Vivado IDE manages this automatically if you attempt to run 
implementation on an un-synthesized design. The tool allows you to run synthesis first. 

For information on running Vivado synthesis, see the Vivado Design Suite User Guide: 
Synthesis (UG901) [Ref 6].

Creating and Opening the Synthesized Design in Non-Project Mode

In Non-Project Mode, you must run the Tcl command synth_design to create and open 
the synthesized design. You can also run the Tcl command link_design to open a 
synthesized netlist in any supported input format. 

For more information, see Opening the Synthesized Design in Chapter 2, Implementation 
Commands.

Loading the Design Netlist in Project Mode Before Implementation

In Project Mode, after synthesis of an RTL design, or with a netlist-based project open, you 
can load the design netlist for analysis before implementation. 

To open a synthesized design, do one of the following:

• From the main menu, run Flow > Open Synthesized Design.

• In the Flow Navigator, run Synthesis > Open Synthesized 
Design.

• In the Design Runs window, select the synthesis run and select 
Open Synthesized Design from the context menu.
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Configuring, Implementing, and Verifying IP
Configuring, Implementing, and Verifying IP
The Vivado IP catalog allows you to configure, implement, and verify IP. The IP can be 
configured and verif ied as a standalone module, or within the context of a larger system 
level design.

IP Catalog Contents
The IP catalog displays all available Xilinx LogicCORE™ IP and user-defined IP or third party 
IP that has been added to the IP catalog.

The catalog includes data related to:

• IP type

• Version

• Datasheet

• License information

Adding an IP Core to an RTL Design
To add an IP core to an RTL design, define the instantiation template into the system-level 
design. 

IP is created as RTL sources, not netlists. Running synthesis and implementation implements 
the IP along with the rest of the design. 

You can also synthesize the IP as a standalone module, and add the netlist to a netlist 
design. 

For more information on how Vivado tools support IP centric design, see the Vivado Design 
Suite User Guide: Designing with IP (UG896) [Ref 5].

Table 1-1: Supported IP Netlist Formats

Xilinx Verilog EDIF

• .xco
• .xci
• .ngc

.v .edf
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Guiding Implementation With Design Constraints
Guiding Implementation With Design Constraints
Xilinx highly recommends that you include design constraints to guide implementation. 
There are two types of design constraints, physical constraints and timing constraints.

This section includes the following:

• What Physical Constraints Define

• What Timing Constraints Define

• UCF Format Not Supported

• Constraint Sets Apply Lists of Constraint Files to Your Design

• Adding Constraints as Attribute Statements

What Physical Constraints Define 
Physical constraints define:

• Pin placement

• Absolute or relative placement of cells, including:

° BRAM

° DSP

° LUT

° Flip flops

• Device configuration settings
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Guiding Implementation With Design Constraints
What Timing Constraints Define
Timing constraints define the frequency requirements for the design, and are written in 
industry standard SDC.

Without timing constraints, the Vivado Design Suite optimizes the design solely for wire 
length and routing congestion, and makes no effort to assess or improve design 
performance. 

UCF Format Not Supported
IMPORTANT: The Vivado Design Suite does not support the UCF format. 

For information on migrating UCF constraints to XDC commands, see the Vivado Design 
Suite Migration Methodology Guide (UG911) [Ref 13].

Constraint Sets Apply Lists of Constraint Files to Your Design
A constraint set is a list of constraint f iles that can be applied to your design. The set 
contains design constraints captured in XDC files. 

Allowed Constraint Set Structures

The following constraint set structures are allowed:

• Multiple constraint f iles within a constraint set

• Constraint sets with separate physical and timing constraint f iles

• A master constraint f ile 

• A new constraint f ile that accepts constraint changes

• Multiple constraint sets

TIP: Separate constraints by function into different constraint files to (a) make your constraint strategy 
clearer, and (b) to facilitate targeting timing and implementation changes.

Multiple Constraint Sets Are Allowed

You can have multiple constraint sets for a project. Multiple constraint sets allow you to use 
different implementation runs to test different approaches.

For example, you can have one constraint set for synthesis, and a second constraint set for 
implementation. Having two constraint sets allows you to experiment by applying different 
constraints during synthesis, simulation, and implementation. 
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Guiding Implementation With Design Constraints
Organizing design constraints into multiple constraint sets can help you:

• Target various Xilinx FPGA devices for the same project. Different physical and timing 
constraints may be needed for different target parts.

• Perform what-if design exploration. Use constraint sets to explore various scenarios for 
floorplanning and over-constraining the design.

• Manage constraint changes. Override master constraints with local changes in a 
separate constraint f ile. 

TIP: To validate the timing constraints, run report_timing_summary on the synthesized design. Fix 
problematic constraints before implementation!

For more information on defining and working with constraints that affect placement and 
routing, see the Vivado Design Suite User Guide: Using Constraints (UG903) [Ref 7]. 

Adding Constraints as Attribute Statements
Constraints can be added to HDL sources as attribute statements. Attributes can be added 
to both Verilog and VHDL sources to pass through to Vivado synthesis or Vivado 
implementation. In some cases, constraints are available only as RTL attributes, and are not 
available in XDC. 

In this case, the constraint must be specif ied as an attribute in the HDL source f ile. For 
example, Relatively Placed Macros (RPMs) must be defined as properties. An RPM is a list of 
logic elements (such as FF, LUT, DSP, and RAM) grouped into a set. 

You can define sets of design elements using U Set (U_SET) or HU Set (HU_SET) constraints, 
and place these objects in relation to the other elements of the set using Relative Location 
Constraints (RLOC). 

For more information about Relative Location Constraints, see the Vivado Design Suite User 
Guide: Using Constraints (UG903) [Ref 7].

The U_SET, HU_SET, and RLOC constraints are not supported in XDC by Tcl commands, and 
bu they be defined as attributes in the HDL source f iles. 

For more information on constraints that are not supported in XDC, see the Vivado Design 
Suite Migration Methodology Guide (UG911) [Ref 13].
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Saving and Restoring Snapshots of a Design with Design Checkpoints
Saving and Restoring Snapshots of a Design with 
Design Checkpoints
The Vivado Design Suite uses a physical design database to store placement and routing 
information. Design checkpoint f iles (.dcp) allow you to save and restore this physical 
database at key points in the design flow. Checkpoints are a snapshot of a design at a 
specific point in the flow. 

This design checkpoint f ile includes the following:

• Current netlist, including any optimizations made during implementation

• Design constraints

• Implementation results

Checkpoint designs can be run through the remainder of the design flow using Tcl 
commands. They cannot be modified with new design sources.

Writing Checkpoint Files 
Run File > Write Checkpoint to capture a snapshot of the design database at any point in 
the flow. This creates a file with a dcp f ile extension. 

The related Tcl command is write_checkpoint.

Reading Checkpoint Files 
Run File > Open Checkpoint to open the checkpoint in the Vivado Design Suite. 

The design checkpoint is opened as a separate project. It can not be read into an existing 
project. 

The related Tcl command is read_checkpoint.
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Running Implementation in Non-Project Mode
Running Implementation in Non-Project Mode
To implement the synthesized design or netlist onto the targeted Xilinx FPGA device, you 
must run the netlist and the design constraints through a series of steps: 

• Optimization

• Placement

• Routing

These steps are collectively known as implementation. 

In Non-Project Mode, you must run implementation using a series of Tcl commands, or a Tcl 
script that defines the design flow. The Tcl commands can be entered into the Tcl Console 
from the Vivado IDE, or from the Tcl prompt in the Vivado Design Suite Tcl shell.

Non-Project Mode Example Script
The following script is an example of running implementation in Non-Project Mode.

# Step 1: Read in top-level EDIF netlist from synthesis tool
read_edif c:/top.edf 
# Read in lower level IP core netlists
read_edif c:/core1.edf
read_edif c:/core2.edf 

# Step 2: Specify target device and link the netlists
# Merge lower level cores with top level into single design
link_design -part xc7k325tfbg900-1 -top top.edf

# Step 3: Read XDC constraints to specify timing requirements
read_xdc c:/top_timing.xdc 
# Read XDC constraints that specify physical constraints such as pin locations
read_xdc c:/top_physical.xdc 

# Step 4: Optimize the design with default settings
opt_design 

# Step 5: Place the design
place_design

# Step 6: Route the design 
route_design

# Step 7: Run Timing Summary Report to see timing results
report_timing_summary -file post_route_timing.rpt 
# Run Utilization Report for device resource utilization
report_utilization -file post_route_utilization.rpt 

# Step 8: Write checkpoint to capture the design database; 
# The checkpoint can be used for design analysis in Vivado IDE or TCL API
write_checkpoint post_route.dcp 
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Running Implementation in Non-Project Mode
Key Steps in Non-Project Mode Example Script
The key steps in the Non-Project Mode Example Script above are:

• Step 1: Read Design Source Files

• Step 2: Build the In-Memory Design

• Step 3: Read Design Constraints

• Step 4: Perform Logic Optimization

• Step 5: Place the Netlist Elements

• Step 6: Route the Design

• Step 7: Run Required Reports

• Step 8: Save the Design Checkpoint

Step 1: Read Design Source Files

In the Non-Project Mode Example Script above, the design sources are EDIF netlist f iles. 
Non-Project Mode also supports an RTL design flow, which allows you to read source f iles 
and run synthesis before implementation. 

The read_* Tcl commands are designed for use with Non-Project Mode. This allows a file 
on the disk to be read by the Vivado Design Suite to build the in-memory design, without 
copying the f ile or creating a dependency on the file.

This approach makes Non-Project Mode extremely flexible with regard to design. 

IMPORTANT: You must monitor any changes to the source design files, and update the design as 
needed.

Step 2: Build the In-Memory Design

In the Non-Project Mode Example Script above, the Vivado tools build an in-memory view 
of the design using link_design. The link_design command combines (a) the netlist 
based source f iles read into the tool with (b) the Xilinx part information, to create a design 
database in memory. 

All actions taken in Non-Project Mode are directed at the in-memory database within the 
Vivado tools. 

The in-memory design resides in the Vivado tool, whether running in batch mode, Tcl shell 
mode for interactive Tcl commands, or in the Vivado IDE for interaction with the design data 
in a graphical form. 
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Running Implementation in Non-Project Mode
Step 3: Read Design Constraints

The Vivado Design Suite uses design constraints to define requirements for both the 
physical and timing characteristics of the design. 

For more information, see Guiding Implementation With Design Constraints, page 13. 

The read_xdc command reads an XDC constraint f ile, then applies it to the in-memory 
design. 

TIP: While Project Mode supports the definition of constraint sets, containing multiple constraint files 
for different purposes, Non-Project Mode uses multiple read_xdc commands to achieve the same 
effect. 

Step 4: Perform Logic Optimization

The Non-Project Mode Example Script above performs logic optimization in preparation for 
placement and routing. Optimization simplif ies the logic design before committing to 
physical resources on the target part. 

The Vivado netlist optimizer includes many different types of optimizations to meet varying 
design requirements. 

For more information, see Logic Optimization, page 70. 

Step 5: Place the Netlist Elements

The Non-Project Mode Example Script above performs a general placement of the design. 
Placement can also be accomplished in stages, according to the design hierarchy, or the 
complexity of the placement challenge. 

For more information, see Placement, page 75. 

Step 6: Route the Design

The route_design command completes the required routing for the design. The Vivado 
router performs timing-driven routing for all design types. The router allows a great deal of 
control for re-entrant routing to complete challenging designs. 

For more information, see Routing, page 84.

Step 7: Run Required Reports

The Non-Project Mode Example Script above generates two of the many reports available 
from the Vivado Design Suite. In Non-Project Mode, you must use the appropriate Tcl 
command to specify each report you want to create. 
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Running Implementation in Project Mode
You can output reports to f iles for later review, or you can send the reports directly to the 
Vivado IDE to review now. 

For more information, see Viewing Implementation Reports, page 60. 

Step 8: Save the Design Checkpoint

The Non-Project Mode Example Script above saves the in-memory design into a design 
checkpoint f ile. The saved in-memory design includes its:

• Optimized netlist

• Physical and timing related constraints

• Xilinx part data

• Placement and routing information

In Non-Project Mode, the design checkpoint f ile saves the design and allows it to be 
reloaded for further analysis and modif ication. 

For more information, see Saving and Restoring Snapshots of a Design with Design 
Checkpoints, page 16.

Running Implementation in Project Mode
In Project Mode, the Vivado IDE allows you to:

• Define implementation runs that are configured to use specific synthesis results and 
design constraints.

• Run multiple strategies on a single design.

• Customize implementation strategies to meet specif ic design requirements.

• Save customized implementation strategies to use in other designs. 

IMPORTANT: Non-Project Mode does not support predefined implementation runs and strategies. 
Non-project based designs must be manually moved through each step of the implementation process 
using Tcl commands. For more information, see Running Implementation in Non-Project Mode, 
page 17.

Creating Implementation Runs
You can create and launch new implementation runs to explore design alternatives and f ind 
the best results. You can queue and launch the runs serially, or in parallel using multiple 
local CPUs. 
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Running Implementation in Project Mode
On Linux systems, you can launch runs on remote servers. For more information, see 
Appendix A, Using Remote Hosts.

Defining Implementation Runs

To define an implementation run:

1. Do one of the following:

° From the main menu, select Flow > Create Runs. 

° In the Flow Navigator, select Create Implementation Runs from the 
Implementation popup menu.

° In the Design Runs window, select Create Runs from the popup menu.

The Create New Runs wizard opens. The f irst page summarizes the command. 

2. Click Next.

Note: If you used Flow > Create Runs, select Implementation on the f irst page of the Create 
New Runs wizard. 

3. Enter a Name for the run in the Configure Implementation Runs dialog box, or accept 
the default name. 

Figure 1-3: Configure Implementation Runs
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4. Select a Synth Name to choose the synthesis run that will be used to generate (or that 
has already generated) the synthesized netlist to be implemented. 

° Alternatively, you can select a synthesized netlist that was imported into the project 
from a third party synthesis tool. 

° For more information, see the Vivado Design Suite User Guide: Synthesis (UG901) 
[Ref 6].

° The default is the currently active synthesis run in the Design Runs window. For 
more information, see Using the Design Runs Window, page 26.

5. Select a Constraints Set.

° Select a Constraints Set to specify the constraint set to apply during 
implementation. The optimization, placement, and routing are largely directed by 
the physical and timing constraints in the specified constraint set. 

° For more information on constraint sets, see the Vivado Design Suite User Guide: 
Using Constraints (UG903) [Ref 7].

6. Select a target Part.

° The default values for Constraints Set and Part are defined by the Project Settings 
when the Create New Runs command is executed.

° For more information on the Project Settings, see the Vivado Design Suite User Guide: 
Using the Vivado IDE (UG893) [Ref 2].

° To create runs with different constraint sets or target parts, use the Create New 
Runs command. To change these values in the Run Properties window, select the 
run in the Design Runs window.

° For more information, see Changing Implementation Run Settings, page 28. 

7. Select a Strategy.

° Strategies are a defined set of Vivado implementation feature options controlling 
the implementation results. Vivado Design Suite includes a set of pre-defined 
strategies. You can also create your own implementation strategies. 

° For more information see Defining Strategies, page 34. 

° Select from among the strategies shown in the following table.

The strategies are broken into categories according to their purposes, with the category 
name as a prefix. The categories are shown in Table 1-2, Categories.

The Performance strategies aim to improve design performance at the expense of runtime. 
The Performance_Explore strategy is a good first choice, because it covers all types of 
designs. 

IMPORTANT: Strategies containing the terms SLL or SLR are for use with SSI devices only.
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Table 1-2: Categories

Category Purpose

Performance Improve design performance.

Area Reduce LUT count.

Power Add full power optimization.

Flow Modify flow steps.

Congestion Reduce congestion and related problems.

Table 1-3: Implementation Strategies

Implementation Strategy Name Description

Vivado Implementation Defaults Balances runtime with trying to achieve timing closure.

Performance_Explore Uses multiple algorithms for optimization, placement, and 
routing to get potentially better results.

Performance_RefinePlacement Increase placer effort in the post-placement optimization 
phase, and disable timing relaxation in the router.

Performance_WLBlockPlacement Ignore timing constraints for placing Block RAM and DSPs, use 
wirelength instead.

Performance_WLBlockPlacementFanoutOpt Ignore timing constraints for placing Block RAM and DSPs, use 
wirelength instead, and perform aggressive replication of high 
fanout drivers.

Performance_LateBlockPlacement Use approximate Block RAM and DSP placement until late 
placement phases. May result in better overall placement.

Performance_NetDelay_high To compensate for optimistic delay estimation, add extra delay 
cost to long distance and high fanout connections. (high 
setting, most pessimistic)

Performance_NetDelay_medium To compensate for optimistic delay estimation, add extra delay 
cost to long distance and high fanout connections. (medium 
setting,)

Performance_NetDelay_low To compensate for optimistic delay estimation, add extra delay 
cost to long distance and high fanout connections. low setting, 
least pessimistic)

Performance_ExploreSLLs Explores SLR reassignments to potentially improve overall 
timing slack.

Area_Explore Uses multiple optimization algorithms to get potentially fewer 
LUTs.

Power_DefaultOpt Adds power optimization (power_opt_design) to reduce 
power consumption.

Flow_RunPhysOpt Similar to the Implementation Run Defaults, but enables the 
physical optimization step (phys_opt_design).
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TIP: Before launching a run, you can change the settings for each step in the implementation process, 
overriding the default settings for the selected strategy. You can also save those new settings as a new 
strategy. For more information, see Changing Implementation Run Settings, page 28.

8. Click More to define additional runs. Specify names and strategies for the added runs. 
See Figure 1-3, Configure Implementation Runs.

9. Click Next.

The Launch Options dialog box opens. See Figure 1-4, Implementation Launch Options.

Flow_RuntimeOptimized Each implementation step trades design performance for 
better runtime. Physical optimization (phys_opt_design) is 
disabled.

Flow_Quick Only placement and routing are run, with all optimization and 
timing-driven behavior disabled. Useful for utilization 
estimation.

Congestion_SpreadLogic_high Spread logic throughout the device to avoid creating 
congested regions. (high setting: highest degree of spreading)

Congestion_SpreadLogic_medium Spread logic throughout the device to avoid creating 
congested regions. (medium setting)

Congestion_SpreadLogic_low Spread logic throughout the device to avoid creating 
congested regions. (low setting: lowest degree of spreading)

Congestion_SpreadLogicSLLs Allocate SLLs such that logic can be spread throughout all SLRs 
to avoid creating congested regions inside SLRs.

Congestion_BalanceSLLs Allocate SLLs such that no two SLRs require a 
disproportionately large number of SLLs, thereby reducing 
congestion in those SLRs.

Congestion_BalanceSLRs Partition such that each SLR has similar area, to avoid creating 
congestion within an SLR.

Congestion_CompressSLRs Partition with higher SLR utilization, to reduce number of 
overall SLLs.

Table 1-3: Implementation Strategies (Cont’d)

Implementation Strategy Name Description
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10. Specify the Launch Directory

° Creates and stores the implementation run data. 

° The default directory is located in the local project directory structure. Files for 
implementation runs are stored by default at: 

<project_name>/<project_name>.runs/<run_name>

TIP: Defining a directory location outside the project directory structure makes the project 
non-portable because absolute paths are written into the project files.

11. Specify the Launch Options.

° Launch Runs on Local Host

Launches the run on the local machine. 

° Number of Jobs

Defines the number of local processors to use when launching multiple runs 
simultaneously. 

° Launch Runs on Remote Hosts (Linux only)

- Uses remote hosts to launch one or more jobs. 

- For more information, see Appendix A, Using Remote Hosts.

X-Ref Target - Figure 1-4

Figure 1-4: Implementation Launch Options
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° Configure Hosts

Configures remote hosts. 

° Generate scripts only

Exports and creates the run directory and run script, but does not launch the run at 
this time. The script can be run later outside the Vivado IDE tool.

° Do not launch now

Saves the new runs, but does not launch or create run scripts at this time. 

12. Click Next to review the Create New Runs Summary.

13. Click Finish to create the defined runs and execute the specif ied launch options. 

New runs are added to the Design Runs window.

Using the Design Runs Window
The Design Runs window displays all synthesis and implementation runs created in the 
project. It includes commands to configure, manage, and launch the runs. 

Opening the Design Runs Window

Select Window > Design Runs to open the Design Runs window if it is not already open. 
See Figure 1-5, Design Runs Window.

Design Runs Window Functionality

• Each implementation run appears indented beneath the synthesis run of which it is a 
child. 

• A synthesis run can have multiple implementation runs. Use the tree widgets in the 
window to expand and collapse synthesis runs. 

• The Design Runs window is a tree table window. 

For more information on working with the columns to sort the data in this window, see the 
Vivado Design Suite User Guide: Using the Vivado IDE (UG893) [Ref 2]. 
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Run Status

The Design Runs window reports the run status, including when the run:

• Has not been started.

• Is in progress.

• Is complete.

• Is out-of-date.

Run Timing Results

The Design Runs window reports timing results for implementation runs including WNS, 
TNS, WHS, THS, TPWS, and the number of failed nets.

Out-of-Date Runs

Runs can become out-of-date when source files, constraints, or project settings are 
modif ied. You can reset and delete stale run data in the Design Runs window. 

Active Run

All views in the Vivado IDE reference the active run. The Log view, Report view, Status Bar, 
and Project Summary display information for the active run. The Project Summary window 
displays only compilation, resource, and summary information for the active run. 

TIP: Only one synthesis run and one implementation run can be active in the Vivado IDE at any time

The active run is displayed in bold text. 

To make a run active:

1. Select the run in the Design Runs window

2. Select Make Active from the popup menu.

Figure 1-5: Design Runs Window 
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Changing Implementation Run Settings

Select a run in the Design Runs window to display the current configuration of the run in 
the Run Properties window. See Figure 1-6, Run Properties Window. 

In the Run Properties window you can change:

• The Name of the run

• The Xilinx Part targeted by the run

• The run Description

• The Constraints set that both drives the implementation and is the target of new 
constraints from implementation

For more information on the Run Properties window, see the Vivado Design Suite User Guide: 
Using the Vivado IDE (UG893) [Ref 2]. 

 

You can also change the options used by Vivado implementation features. 

Specifying Design Run Settings
Specify design run settings in the Design Run Settings dialog box. To open the Design Run 
Settings dialog box:

1. Select a run in the Design Runs window.

2. Select Change Run Settings from the popup menu.

See Figure 1-7, Design Run Settings.

TIP: You can change the settings only for a run that has a Not Started status. Use Reset Run to return 
a run to the Not Started status. See Resetting Runs, page 31. 

Figure 1-6:  Run Properties Window
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The Design Run Settings dialog box displays: (1) the implementation strategy currently 
employed by the run; and (2) the command options associated with that strategy for each 
step of the implementation process. The command options are:

• Strategy

• Description

• Options

Strategy

Selects the strategy to use for the implementation run. Vivado Design Suite includes a set 
of pre-defined implementation strategies, or you can create your own. 

For more information see Defining Strategies, page 34. 

Description

Describes the selected implementation strategy.

Figure 1-7:  Design Run Settings
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Options

When you select a strategy, each step of the Vivado implementation process displays in a 
table in the lower part of the dialog box:

• opt_design

• power_opt_design

• place_design

• phys_opt_design

• route_design

• write_bitstream

Click a specific command option to view a brief description of the option at the bottom of 
the Design Run Settings dialog box. 

For more information about the various implementation steps, and their available options, 
see Chapter 2, Implementation Commands.

Modifying Command Options

To modify command options, click the right-side column of a specif ic option. You can do 
the following:

• Select options with predefined settings from the pull down menu. 

• Select or unselect a check box to enable or disable options. 

• Type a value to define options that accept a user-defined value. 

• Options accepting a file name and path open a f ile browser to let you locate and 
specify the f ile. 

• Insert a custom Tcl script (called a hook script) before and after each step in the 
implementation process (tcl.pre and tcl.post). 

Inserting a hook script lets you perform specif ic tasks before or after each 
implementation step (for example: generate a timing report before and after Place 
Design to compare timing results). 

For more information on defining Tcl hook scripts, see the Vivado Design Suite User Guide: 
Using Tcl Scripting (UG894) [Ref 3].

TIP: Relative paths in the tcl.pre and tcl.post scripts are relative to the appropriate run directory 
of the project they are applied to: <project>/<project.runs>/<run_name>
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Use the DIRECTORY property of the current project or current run to define the relative 
paths in your Tcl scripts: 

get_property DIRECTORY [current_project]
get_property DIRECTORY [current_run]

Save Strategy As

Select the Save Strategy As icon next to the Strategy f ield to save any changes to the 
strategy as a new strategy for future use. 

CAUTION! If you do not select Save Strategy As, changes are saved to the current 
implementation run, but are not preserved for future use. 

Verifying Run Status
The Vivado IDE processes the run, and launches implementation, depending on the status 
of the run. The status is displayed in the Design Runs window. See Figure 1-5, Design Runs 
Window.

• If the status of the run is Not Started, the run begins immediately. 

• If the status of the run is Error, the tool resets the run to remove any incomplete run 
data, then restarts the run. 

• If the status of the run is Complete (or Out-of-Date), the tool prompts you to confirm 
that the run should be reset before proceeding with the run.

Resetting Runs

To reset a run:

1. Select a run in the Design Runs window.

2. Select Reset Runs from the popup menu. 

Resetting an implementation run returns it to the first step of implementation (opt_design) 
for the selected run. 

 
X-Ref Target - Figure 1-8

Figure 1-8: Reset Run
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The Vivado tool prompts you to confirm the Reset Runs command, and optionally delete 
the generated f iles from the run directory.

TIP: The default setting is to delete the generated files. Disable this check box to preserve the generated 
run files. 

Deleting Runs

To delete runs from the Design Runs window:

1. Select the run.

2. Select Delete from the popup menu. 

The Vivado tool prompts you to confirm the Delete Runs command, and optionally delete 
the generated f iles from the run directory. 

TIP: The default setting is to delete the generated files. Disable this check box to preserve the generated 
run files. 

 

Customizing Implementation Strategies
Implementation Settings define the default options used when you define new 
implementation runs. Configure these options in the Vivado IDE.

Figure 1-10, Implementation Settings, shows the Implementation Settings of the Project 
Settings dialog box. To open this dialog box from the Vivado IDE, select Tools > Project 
Settings from the main menu. 

TIP: The Project Settings command is not available in the Vivado IDE when running in Non-Project 
Mode. In this case, you can define and preserve implementation strategies as Tcl scripts that can be 
used in batch mode, or interactively in the Vivado IDE.

X-Ref Target - Figure 1-9

Figure 1-9: Delete Runs
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Accessing Implementation Settings for the Active Run from 
Flow Navigator
Implementation Settings for the active implementation run can 
also be accessed directly from the Flow Navigator. 

Implementation Settings contains the following f ields :

• Default Constraint Set

Select the constraint set to be used by default for the implementation run. 

• Strategy

Select the strategy to use for the implementation run. Vivado Design Suite includes a set 
of pre-defined strategies. You can also create your own implementation strategies. 

For more information see Defining Strategies. 

• Save Strategy As

Saves any changes to the strategy as a new strategy for future use. 

• Description

° Describes the selected implementation strategy.

° The description of user-defined strategies can be changed by entering a new 
description. 

° The description of Vivado tools standard implementation strategies cannot be 
changed.
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Defining Strategies
A strategy is a defined approach for resolving the synthesis or implementation challenges 
of the design. 

• Strategies are defined in pre-configured sets of options for the Vivado implementation 
features. 

• Strategies are tool and version specific. 

• Each major release of the Vivado Design Suite includes version-specific strategies. 

X-Ref Target - Figure 1-10

Figure 1-10: Implementation Settings
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Vivado implementation includes several commonly used strategies that are tested against 
internal benchmarks. 

TIP: You cannot save changes to the predefined implementation strategies. However, you can copy, 
modify, and save the predefined strategies to create your own. 

Figure 1-11:  Default Implementation Strategies
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